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1 Documentation

About the documentation

This User's Guide is divided into four parts:

Getting Started - contains general information about TerraMatch and instructions on how to
install and run the application.

Tutorial - contains lessons introducing how to process an example data set.

Tool Reference - contains descriptions of all the tools in TerraMatch.

Algorithmic Reference - contains basic explanations of the underlying algorithms.
Additional Information - contains information about installation configuration.

Accessing documentation on-line

The documentation is accessible as an Acrobat Reader document which serves the role of on-line
help. Accessing the electronic format of the documentation has the following unique advantages:

You can conduct automated searches for keywords in topic names or body text.
You can click hypertext to "jump" to related topics.

Document conventions

The following conventions and symbols appear in this guide:

Keyboard keys are enclosed with angle brackets - for example, <Return>.

Alternate procedures are separated by "OR".

Alternate steps in a procedure are separated by "or".

"Key in" means to type a character string and then press <Return> (or <Tab> in dialogs).
The following icons are used to specify special information:

Icon: Appears next to:
& Notes

v Hints and shortcuts
> Procedures

When no distinction between MicroStation SE, MicroStation J, MicroStation V8 and
MicroStation GeoOutlook is necessary, this document refers to the CAD environment simply
as "MicroStation".

MicroStation documentation

This document has been written assuming that the reader knows how to use basic MicroStation
features. You should refer to MicroStation printed documentation or on-line help whenever you
need information on using the CAD environment.
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2 Introduction to TerraMatch

Introduction

TerraMatch fixes systematic orientation errors in airborne laser data. It measures the differences
between laser surfaces from overlapping flightlines or differences between laser surfaces and
known points. These observed differences are translated into correction values for the system
orientation -- easting, northing, elevation, heading, roll and/or pitch.

TerraMatch can be used as a laser scanner calibration tool or as a tool for fixing actual project data.
When used as a calibration tool, it will solve the misalignment between the laser scanner and the
inertial measurement unit. The end result is correction values for heading, roll and pitch which
apply for the whole data set.

Actual project data may contain error sources which apply to the whole data set or error sources
which vary within the data set. TerraMatch can solve correction parameters for the whole data set
and/or individual correction parameters for each flightline.

TerraMatch is loosely integrated with TerraScan. In order to run TerraMatch, one will have to do
some preprocessing steps with TerraScan but those tasks can be performed by another user at
another workstation.

Data requirements

In order for the algorithms to work properly, the input data must meet some requirements:

* The data set should contain multiple flightlines which overlap each other. Alternatively, one
could have just a single flightline and compare against a dense set of known points.

* The data set contains some well defined surfaces -- matching can not be performed if all of
the data is hits in forest canopy where no meaningful surfaces can be constructed.

» Time stamped trajectory information has been imported into TerraScan.

* A trajectory should not overlap itself. Any trajectories which make a 180 degree turn and
return over itself, should be split into two parts using TerraScan.

» Laser points are linked to trajectory positions so that TerraMatch can derive the laser scanner
position and orientation for each laser point. This requires that laser points have flightline
numbers and time stamps matching trajectory information.

» Laser points on suitable surfaces have been classified in each flightline independently. This
may involve automatic ground classification and/or manual classification of suitable sloped
surfaces such as building roofs.
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Calibration workflow

TerraMatch can be used to solve the mirror scale parameter and the misalignment between the
laser scanner and the inertial measurement unit. The misalignment is expressed as heading, roll
and pitch angular correction values which need to be known for every laser scanner system.

Different laser scanners may require additional calibration parameters as well. Those must be
solved using more manual methods with TerraScan or with system specific software.

Flight pattern

The optimal site for a calibration flight contains both flat and sloped surfaces which do not have
disturbing surface objects such as low vegetation. The most commonly used target area for
calibration is an airport as it is easily accessible and most often contains suitable surfaces.

The minimum flight pattern for calibration is four flight passes over the same area in a cross like
pattern where the slopes surfaces are located at the center of the cross:

Y ou may consider some additional flight passes which may improve the quality of the calibration:

* An additional flight pass for which the sloped surfaces are located at the right of left edge of
the corridor covered. This will help to differentiate pitch and heading from each other.
» Additional flight passes at a higher or a lower altitude.

Processing steps
The processing of a calibration flight can be outlined as the following steps:

1. Solve GPS trajectories.

2. Compute xyz laser points with system specific software using last known calibration values.
3. Import trajectories into TerraScan and transform to any coordinate system.

4.  Split any trajectories which overlap themselves.
5

Import time stamped laser points into TerraScan and transform to the same coordinate
system.

6. Make sure flightline numbering of laser points matches trajectory numbers (use Deduce
using time command from Flightline pulldown menu).

Classify low points.
8.  Classify ground separately for each flightline.
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9.  (Optional) Classify buildings manually.
10. Smoothen ground surface if most of it is asphalt or some other hard surface.

11. Run Find Match and solve for heading, roll, pitch and mirror scale corrections for the whole
data set.

12.  Add the result values to the correction values used when computing the xyz points in step 2.
The laser scanner has may have operation modes which make calibration easier such as profile

mode. If such a mode is available, it should be used to solve pitch correction value first and
TerraMatch should be used to solve for heading and roll correction only.
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Project workflow

Even though the system has been calibrated, you may still find systematic errors in project data.
TerraMatch can be used with actual project data to solve mismatches between laser data from
different flightlines or between laser data and known points.

As the project data volume can be huge, it is desirable to minimize the number of steps in the
processing workflow. You probably want to run TerraMatch only if you notice first that there are
significant mismatches in the laser data.

Another difficulty with project data is that you do not know the nature of the errors beforehand.
Mismatches may be a result of mistakes made at setting up GPS reference stations, at computing
trajectories or at operation of the airborne system. As a part of solving for correction parameters,
you must at the same time establish what parameters need to be corrected!

Project workflow may be outlined as the following steps:

Solve GPS trajectories.
Compute xyz laser points with system specific software using last known calibration values.
Import trajectories into TerraScan.

Import time stamped laser points into TerraScan.

A

Compare flightlines visually in cross sections. Try to locate sloped surfaces both along
flight direction and perpendicular to flight direction.

6. If no significant mismatches are visible, you may skip the consecutive steps and continue
with normal processing workflow.

Classify low points.
8.  Classify ground for each fligthline.

(Optional) Locate areas which are best suited for matching and classify ground in those
areas to another class.

10. (Optional) Classify buildings manually at the locations which are best suited for matching.

11. Run Find Match and solve for heading, roll, pitch and mirror scale corrections for the whole
data set.

Apply the correction if it is significant.

12. Compare flightlines visually in cross sections or use distance coloring to determine if step
11 fixed the mismatches.

Youneed to decide if the correction was good or if you need to back to step 11 and try solving
for a different combination of correction parameters for the whole data set.

13. Run Find Match and solve for elevation correction for individual flightlines.
Apply the correction if it is significant.

14. Compare flightlines visually in cross sections or use distance coloring to determine if step
13 improved the data.

Youneed to decide if the correction was good or if you need to back to step 13 and try solving
for a different combination of correction parameters for individual flightlines.
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Terra application family

TerraMatch is just one in a full family of civil engineering applications. All of Terra applications
are tightly integrated with MicroStation presenting an easy-to-use graphical interface to the user.

TerraBore is a solution for reading in, editing, storing and displaying bore hole data. You can
triangulate soil layers with the help of TerraModeler.

TerraModeler creates terrain surface models by triangulation. You can create models of ground,
soil layers or design surfaces. Models can be created based on survey data, graphical elements or
XYZ text files.

TerraPark is an easy-to-use package for park design and landscaping. It has all the necessary
tools for designing roads, regions, plants and utilities inside the park.

TerraPhoto rectifies digital photographs taken during laser scanning survey flights and produces
orthorectified images.

TerraPipe is used for designing underground pipes. It gives you powerful tools for designing
networks of drainage, sewer, potable water or irrigation pipes.

TerraScan processes laser scanning data. It reads in laser points from text files and lets you view
the points three dimensionally, classify the points and create vectors based on the points.

TerraStreet is an application for street design. It includes all the terrain modeling capabilities of
TerraModeler. Street design process starts with the creation of horizontal and vertical geometries
for street alignments.

TerraSurvey reads in survey data and creates a three dimensional survey drawing. The
application recognizes a number of survey data formats automatically.

All of these applications are available for MicroStation SE, J or V8 under Windows NT, Windows
2000 or Windows XP.
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3 Installation

Hardware and software requirements

TerraMatch is built on top of MicroStation. You must have a computer system capable of running
this CAD environment.

To run TerraMatch, you must have the following:

* Pentium or higher processor

¢ Windows XP, 2000, NT 4.0, 95, 98 or ME (XP or 2000 or NT 4.0 recommended)

* mouse

* 1024*768 resolution display or better

* 256 MB RAM

*  MicroStation SE, MicroStation J, MicroStation V8 or MicroStation GeoOutlook installed

Installation of TerraMatch requires about 1 MB of free hard disk space.

Installation media

TerraMatch software may be delivered on CD or as a zip file.

The zip package is big enough only to contain the actual software — it does not include the
example data set or the on-line Acrobat manual.

Terra Installation CD includes the software, example data and the on-line documentation. When
you install from the CD, the software and the documentation will be copied to you hard disk. If
you want to use the example data, you should access it directly from the CD or copy it to the hard
disk yourself. See Tutorial on page 17 for more information about the example data.

Terra Installation CD may include versions for multiple environments. You should locate the
directory which corresponds to your operating system:

Directory on CD For operating system For MicroStation
\windows\eng Windows for Intel SE, J, V8or GeoOutlook
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Installation from zip file

»  To install TerraMatch from zip file:

15.
16.

17.

18.

19.

20.

Open the TMATCH.ZIP file in WinZip.
Click on Install icon in the WinZip tool bar.

This opens the Install dialog confirming the execution of SETUP.EXE
Click OK.

The installation program will need to know where MicroStation has been installed. It will
automatically search all local hard disks to find the MicroStation directory.

The installation dialog box opens:

TerraMatch for MicroStation SE/]

‘wielcome to Terra Setup program. T hiz program
=] will ingtall a Tena application on pour computer.

Enter directon where to install thiz application,

Inztall ta: |c: terra

Enter directon where MicroStation has been installed,

MicroStation: |C:\msi\F’rngram\MicrnStation
[MicraStation SE orJ or GeoOutlook]

The installation program prompts you to enter the directory where to install TerraScan. The
default path is C:\TERRA. You can set this to another location if you prefer. The specified
directory will be automatically created, if it does not exist.

At this stage you should check the directory where MicroStation was found. Replace the
path if the correct location was not found.

Press <Return> to continue.

When the installation is finished, a message is displayed and you are prompted to press any
key to continue.

See chapters Installation Directories on page 43 and Configuration Variables on page 44 for
more information.

Installation from CD

> To install TerraMatch from CD:

1.

Insert Terra Installation CD into your CD-ROM drive.
Locate the correct directory which corresponds to your computer configuration.
Start SETUP.EXE from that directory.

The installation program will try to determine where MicroStation has been installed and will
then open the Terra Setup dialog box:



Page 14
3 Installation

Terra Setup = |
Welcome to Terra Setup program. T hig program will install Tera @ 1
applications on your compLter. E

Erter directony where to ingtall Terra applications.

Inztall to; |c:\tena

Enter MicroStation directary and check wersion information.

MicroStation: |I::'\msi'\F‘mgram'\MicmStatinn ﬂ
: - - Broweze. .
“Wersion: |M|cmStat|nnJ ﬂ —_—
Cancel

The installation program prompts you to enter the directory where to install the
applications. The default path is CATERRA. You can set this to another location if you
prefer. The specified directory will be automatically created, if it does not exist.

Check the directory where MicroStation was found. Replace the path if the correct location
was not found.

Alternatively, you can use the Scan button to automatically search the hard disk for
MicroStation installation or you can use the Browse button to locate the MicroStation
executable yourself.

Check the MicroStation version information in the Version field. Select the correct version
if it was not detected correctly.

The installation program will want to know what applications you want to install. The Terra
Setup dialog opens:

Terra Setup B
Select applications to install:

iT enah atch for MicroStation SE AL
Tenatdodeler for MicroStation SEA
TemnaPark. for MicroStation SEA
TenaPhata for MicroStation SEA
TenaPipe for MicroStation SEA
TenaScan for MicroStation SEA
TemaStreet for MicroStation SEA
TemaSurvey for MicraStation SE A
Tematdodeler Field SEA
TemnaStrest Field SEAI
TenaSurvey Field SEA
TenaPhaoto Wiewer SEA
TemaScan Viewer SEA

S S s s

o
s

Cancel

Check TerraMatch for MicroStation item in the dialog. You would normally check
TerraScan for MicroStation as well to install it at the same time.

Click OK.

A message is display when the installation is finished.

See chapters Installation Directories on page 43 and Configuration Variables on page 44
for more information.



Page 15
4 Starting TerraMatch

o Starting TerraMatch

Starting TerraMatch

TerraMatch is an MDL application that runs within MicroStation.

> To start TerraMatch:
1.  From the Utilities menu, choose MDL Applications.
The MDL settings box opens:

Loaded Applications

IGEM
MSOPENGLINTF
OLECMTR
WEBTAG

Available Applications
Tazk 1D Filenarne: Laad

TIMSPECT tinzpect.ma
TLIME. Hirk.ma Browse...

Lf|da;

TMATCH tmatch.ma

THODEL trodel. ma
TRARE. tpark.ma

. Inthe Available Applications list box, select TMATCH.
3. Click the Load button.

OR
1. Keyin MDL LOAD TMATCH.

TerraMatch adds an Applications menu to MicroStation’s menu bar and opens the TerraMatch
tool box.

ol aln] = 8] 2

Available Applications list box shows all the MDL applications that MicroStation is able to
locate. MicroStation searches for MDL applications in the directories listed in MS MDLAPPS
configuration variable. If MicroStation can not find TMATCH.MA, you should check the value
assigned to this configuration variable. Make sure the directory path of TMATCH.MA file is
included in this variable. To view configuration variables, choose Configuration command from
the Workspace menu. See Installation Directories on page 43 and Configuration Variables on
page 44 for more information.
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Unloading TerraMatch

TerraMatch will unload automatically when you exit MicroStation. Sometimes you may want to
unload TerraMatch while continuing to work with MicroStation. This will free up memory
reserved by TerraMatch.

»  To unload TerraMatch:
1. From the Utilities menu, choose MDL Applications.

The MDL settings box opens:

Loaded Applications
IGEM Detail ..
MSOPENGLIMTF

OLECHTR Unload
TMATCH

WEBTAG Keyrs...

Available Applications

Tazk 1D Filenarne:
ALIASMGR aliazmar.ma
ASCGROUP  azcgroup.ma Browse...

Wijgdd;

AUTOPLOT  autoplot.ma
BASELIME bazeline ma
CalCuLaT calculat.ma

. Inthe Loaded Applications list box, select TMATCH.
3. Click the Unload button.

OR
1. Keyin MDL UNLOAD TMATCH.

This will unload the application and free the memory allocated for it.
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S Tutorial

This tutorial will help you learn the basic tools in TerraMatch by processing an example
calibration data set. The data set is delivered on Terra Installation CD.

The data set is provided as a courtesy of TopEye AB, Sweden.
Completing this tutorial requires that you have TerraScan running on the same computer.

This tutorial assumes that you are already familiar with MicroStation and know how to manipulate
view windows, how to open design files and how to start MDL applications.

Copying example data from CD

The example data set is located in \example\calib directory on Terra Installation CD.

You should copy the whole calib directory to your hard disk -- for example to c:\terra\calib. As a
result, you should have the following directory structure:

c:\terra\calib directory where the example data set is copied
[ dgn directory for design files

calib.dgn example design file
[ laser directory for processed laser points

distance.clr  color scheme for distance coloring

calib.mac classification macro
calib.ptc point classes for calibration data
[ laserraw raw laser points as binary files

line01.bin  flight pass #1 points
line02.bin  flight pass #2 points
line03.bin flight pass #3 points
line04.bin  flight pass #4 points

[ trajectory for application files

[ trajraw raw system trajectory files
02f11.cte flight pass #1 trajectory
03fll.cte flight pass #2 trajectory
04f11.cte flight pass #3 trajectory
05fl1.cte flight pass #4 trajectory

Files copied from a CD are often marked as read-only. You should switch off the Read-only
attribute for the design file (c:\terra\calib\calib.dgn) copied to your hard disk.
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Opening an example design file

This tutorial will use an example design file which has the proper coordinate system setup for the
data set.
> Top open the example design file:
1.  From MicroStation’s File menu, choose Open.
The Open Design File dialog box opens.

2. Locate calib.dgn design file by browsing your computer’s directory structure. If you copied
the example data to c:\terra\calib, you can find this design file as
c:\terra\calib\dgn\calib.dgn. When you have located this file, select it in the Files list box.

Alternatively, you can type in the full path of the example file in the Files text control.
3. Click OK.

This opens the design file. You should see three view windows open with the Window 1
displaying a shape element with four vertices.

Starting TerraScan

To start TerraScan, go through the steps described in chapter Starting TerraScan in TerraScan
User’s Guide.



Enabling UTM zone 32N

Lih

Page 20
5 Tutorial

The first actual task in the processing of the example calibration data is importing trajectories into
TerraScan.

The raw laser data has already been transformed into UTM coordinate system but the trajectory
information is still in WGS84. We therefore need to enable UTM zone 32N and transform the
trajectories when importing.

To enable UTM zone 32N:

1.

Select the Settings tool from TerraScan’s General tool box.

This opens the TerraScan settings window.

Click on Coordinate transformations row in the Category list.

This opens that folder.

Click on Builtin projection systems row under that folder.
Set UTM WGS North field on.

Type values 30 and 35 into Zones fields to enable European UTM zones.

8 TerraScan settings !. I:I

=3 Settings
3 Coordinate transformations

B2l Transformations
B3 US State Planes
B2 User projection systems
23 File farmats
£ Powerlines
B2 Alignment reports
2 Collection shapes
E= Default flightline qualities
B2l Elevation labels
E2 Loaded points
E= Dperation
B2 Paint dizplay
E2 Target objects
E= Tree types
B2l Tunnel sections

B Builtin projecti

[»

Enable target systems

Deutzche Bahn GE
Finnizh K1

Japan

South Africa
Swedizh RTAE0
UF. Mational Grid
UTH WIES Morth
UTH WiES South

L L L R e

Eguation:  Automatic hd

Zohes |30 - |35

This enables the UTM zones as target coordinate systems for transforming input data.
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Importing trajectories

i

Raw trajectory information needs to be imported into TerraScan, transformed into the right
coordinate system and checked if there is any flightline which overlaps itself.

Defining trajectory directory

>

The first step is to define the directory where trajectory information will be stored.

To define trajectory directory:

1.

Select the Manage Trajectories tool from TerraScan’s General tool box.

This opens the Manage Trajectories window:

gManage Trajectories B

File Trajectory Wiew

Murmber Dezcription Start time Diuration

Show location | Identify |

Select Set directory from File pulldown menu.
This opens a dialog for selecting a directory.

Browse your directory structure and locate c:\terra\calib\trajectory directory.
Click OK.

Importing trajectories

>

The second step is to actually import the trajectory information.

To import trajectories:

L.

A

Select Import trajectories from File pulldown menu.
This opens a dialog for selecting multiple files to read.

Browse your directory structure and locate c:\terra\calib\trajraw directory.
Select all four cte files in that directory.

Click Add to add those files to the list of files to read.

Click Done to accept the files to read.

This opens the Import trajectories dialog where you can select the coordinate
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transformation to apply:

Import trajectories [ |
Firzt nurmber:

5535254

L} 433623

WiE584:  UTM-32M [SE] =

Tranzform:  MNone hd

Input angles:  TopEye radian: ™
I Adust heading

OF. | Cancel |

Select UTM-32N (9 E) option in the WGS84 field.
Select None option in the Transform field.

Set Adjust heading field on.

6
7
8. Select TopEye radians in the Input angles field.
9
10. Click OK.

TerraScan reads raw trajectory information, transforms it to the right coordinate system and
stores into the selected directory.

The list box should now display four trajectories as shown below:

gTraiectnries c:hterrahcalib' trajectory’,
File Trajectory Wiew

Murmber Dezcription Start time Diuration
1 02f11.cte 295473.000 71.000
2 03f11.cte 295569000 73.000
3 04f11.cte 295697000 48.000
4 05F11.cte 295791.000 42.000

Identify

Checking for self overlap
The third step in importing trajectories is to check that no trajectory overlaps itself. Any such
trajectory would have to be split into smaller parts.
»  To check trajectories for overlap:

Set 2 as the active level in MicroStation.
Select red as the active color in MicroStation.
3. Select Draw into design from Trajectory pulldown menu.

This opens the Draw trajectories dialog:

Draw trajectories H
Draw:  All rajectories ™
LColor by Active color ™
[¥ Thin positions

Accuracy m

0K Cancel |

Select All trajectories option in the Draw field.
5. Select Active color in the Color by field.
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6. Set Thin positions on.
Key in 0.50 in the Accuracy field.
Click OK.

This draws the trajectories as red linear elements in the design file.
9. Zoom out Window 1 to see the complete paths of the flightlines.

You should notice that four trajectories form a cross pattern and that no trajectory overlaps
itself.

Loading laser data

=

The raw laser data has already been transformed into UTM zone 32 and is organized as four binary
files -- one for each flightline.

To compare the overlapping flightlines, we only need to use the central area of the data set where
all four flightlines overlap each other.
To import laser data:

Use MicroStation’s Selection tool to select the while shape element on level 1.

2. Select the Load Airborne Points tool from TerraScan’s General tool box.

This opens a dialog for selecting multiple files to read.

3. Browse your directory structure and locate c:\terra\calib\laserraw directory.
4.  Select all four bin files in that directory.
5. Click Add to add those files to the list of files to read.
6. Click Done to accept the files to read.
This opens the Load Points dialog.
7.  Set Inside fence only setting on.

8.  Set Load time stamps setting on.
Click OK.

This loads 363 thousand points from four different flightlines.

Assigning flightline numbers

Each laser point needs to be linked to the correct trajectory in order for TerraMatch to work
properly. If the GPS week second time stamps are unique, this can be done in one simple step.
To assign flightline numbers:

1.  Select Deduce using time from Flightline pulldown menu in TerraScan Main window.

TerraScan finds the matching trajectory for the time stamp of each laser point.
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Viewing laser data

You should now use TerraScan viewing tools to take a look at the laser data. You may want to
display the points using elevation coloring in the top view window and to draw some cross
sections from selected positions using flightline coloring in those views.

Y ou should notice that the terrain is mostly flat and bare without much vegetation. An elevated
road runs along the center of two flightlines giving us nice sloped surfaces for comparing laser
data.

You should also notice that the flightlines do not match each other as there has been no forehand
knowledge of the misalignment between the laser scanner and the inertial measurement unit.
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Cross section using flightline coloring

Performing classification

We should not use all of the points when comparing flightlines agains each other. There are some
low points below the ground and a good number of vegetation hits which would disturb the
comparison of surfaces.

As there are no buildings at this site, we only need to classify ground for each flightline. The
easiest way to do this is by running a macro which method supports separate processing of each
individual flightline.
»  To load a classification macro:
1. Select Macro from Tools pulldown menu in TerraScan Main window.
This opens the Macro dialog.
2. Select Open from File pulldown menu.
This opens a dialog for selecting one file.

3. Locate and open c:\terra\calib\laser\calib.mac file.
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The Macro dialog should now display a macro with four steps:

3 Macro - calib.mac O] x|

File Run

Description: | Test macro
Authar: |

V¥ Process flightlines separately

ow(1,7.2,05010.00,0]
FrScanClagzifyGround(1,2,1,15.0,88.00,6.00,1.20,-1 5.0,0,2.0,0] ;
FriScanClassifyE elow(2,7,8.00,0.10,0] Edit...
FrnSeanSmoothen(''2".0.120,0,120," 0]

d

Delete

iLbEE

Mowe down

The four macro steps are:

* Low point classification -- points below the ground would disturb the comparison.
* Ground classification -- picks ground hits and leaves vegetation points out.
» Below surface classification -- further filters out points below the ground.
* Smoothing ground -- may be beneficial when you know that the ground is smooth. Minimizes
random noise from surfaces and makes it easier to observe the true differences.
»  To run the macro:
1. Select On loaded points from Run pulldown menu.
This opens a dialog for confirming the action.

2. Click OK.

You can close the Macro dialog when the process is complete. You may want to switch all other
classes of in the cross section views and only keep ground visible.

You should now save the classified points as file c:\terra\calib\laser\calib.bin using Scan binary
8bit lines file format. Make sure that Save time stamps setting is on when saving the file.

Loading TerraMatch

All the preprocessing steps in TerraScan have been completed and we can move onto using
TerraMatch.

To start TerraMatch, go through the steps described in chapter Starting TerraMatch on page 15.
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Checking iteration parameters

Lih

It is a good idea to check iteration parameters before finding correction values. You may change
the iteration parameters based on the size of your data set and whether you want to find the final
correction values or just get an indication of the type of errors.

To check iteration parameters:

L.

A AP AT LB o
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— O

Select the Settings tool from TerraMatch tool box.
This opens the Settings window.

Click on Iteration convergence row in the Category list.
Set Heading field to value 0.0001 degrees.

Set Roll field to value 0.0001 degrees.

Set Pitch field to value 0.0001 degrees.

Click on Standard deviations row in the Category list.
Set Elevation field to value 0.100 meters.

Set Heading field to value 0.020 degrees.

Set Roll field to value 0.010 degrees.

Set Pitch field to value 0.010 degrees.

Close the Settings window.
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Solving misalignment between laser scanner and IMU

%
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Viewing the points in cross sections has already proven that we have a significant misalignment
between the laser scanner and the inertial measurement unit. This misalignment can be modeled
as heading, roll and pitch correction values which apply for the whole data set.

We should solve for mirror scale at the same time as it is one of the calibration parameters for an
oscillating mirror used in the system.

To solve misalignment correction:

1.

A SO B AT LRl o

I1.

12.
13.

Select the Find Match tool from TerraMatch tool box.
This opens the Find match dialog:

ilsed Loaded points ¥

=

Trajectary dit: | c:hcalibhtrajectan® Browse...
LComect: Al flightlines hd

Known points: | Browze. .

lze claszes weight

1 Defaul j Select al

2 Ground
3 Low veqgetation

4 Medium vegetation

5 High veqetation

E  Building -| Deselect al |

Obszerve eveny: |1 th point
[ Usze intensiby

Solve for.  “Whole data set ™

E asting shift [ Easting drift
Marthing shift [ Morthing drift
£ zhift [~ Z dift
Heading zhift [ Heading drift
Rall zhit [~ Roll drift
Fitch shift [ Pitch dift
irror zcale

0K Cancel

<<= <7171 71

Select Loaded points option in the Use field.

Enter the trajectory directory into the Trajectory dir field.

Leave the Known points field empty as we have no known points.

Make sure only Ground class is selected in the Use classes list.

Click on Weight column on Ground class row to switch the weight to Normal.
Key in 1 in the Observe every field.

Select Whole data set option in the Solve for field.

Make sure only Heading shift, Roll shift, Pitch shift and Mirror scale correction
parameters are on.

Make sure other settings are as shown in the picture above.
Click OK.

TerraMatch performs a few iteration round comparing the laser surfaces from different
flightlines to each other.

This opens the Apply results dialog displaying the correction values found.

Take a look at the report to see the magnitude of correction values.

Select Save As text from File pulldown menu and select a file name for storing the report.
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14. Click OK to apply the correction to loaded points.

This applies the correction to loaded points which should make the different flightlines
match each other much better.

You should now save the laser points to file c:\terra\calib\laser\calib_hrp.bin.

Searching for flightline elevation corrections

In addition to finding the misalignment values for the whole data set, it may be of interest to see
how much the laser data can be improved by adjusting individual flightlines. When finding
correction values for individual flightlines, you should take more care in selecting what
parameters to solve for. Elevation and roll corrections are the most common ones as those can be
determined with the best reliability. Pitch and heading corrections for individual flightlines place
bigger requirements on suitability of the data set.

We will solve for elevation differences only.

»  To solve elevation correction for each flightline:
1. Select the Find Match tool from TerraMatch tool box.
This opens the Find match dialog:

Uze: Loaded points ™™

Trajectary dit: | c:hcalibhtrajectan® Browse...
LComect: Al flightlines hd

Known points: | Browze. .

lze claszes weight

1 Defaul j Select al

Ground Mormal

3 Low veqgetation
4 Medium vegetation
5 High veqetation
E  Building -| Deselect al |

Obszerve eveny: |1 th point
[ Usze intensiby

Solve for:  Individual lines ™

E asting shift [ Easting drift
Marthing shift [ Morthing drift
£ zhift [~ Z dift
Heading zhift [ Heading drift
Rall zhit [~ Roll drift
Fitch shift [ Pitch dift
irror zcale

=
-
-
-
-
-
-

Cancel

Select Individual lines option in the Solve for field.

Make sure only Z shift correction parameter is on.

Make sure other settings are as shown in the picture above.
Click OK.

A

TerraMatch performs a few iteration round comparing the laser surfaces from different
flightlines to each other.

This opens the Apply results dialog displaying the correction values found.

6. Take a look at the report to see the magnitude of correction values.

7.  Select Save As text from File pulldown menu and select a file name for storing the report.



8.

You should now save the laser points to file c:\terra\calib\laser\calib_hrp dz.bin.

Click OK to apply the correction to loaded points.
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This applies the correction to loaded points which should make a small improvement on how

well different flightlines match each other.

Viewing distance coloring

The final step in processing the calibration data set is to view how well flightlines match each

other. One good way of doing that is using Distance coloring mode in TerraScan.

»  To view distance colored ground points:

1.

el A o

10.
I1.
12.

Select Display mode command from View pulldown menu in TerraScan Main window.

This opens the Display mode dialog:

# Display mode x|
Wiew: 1
Calar by Distance LColors...
[ B
Weight: 1
Lires:  Selected Select...

[~ Sparze digplay

[~ Use depth
Al0n | | O Default =
E Ground
O Low vegetation
O tedium vegetation
O High vegetation
a0t || O euiing =
Lpply | Al viewg |

Select a top view in View option button. You probably have view 1 in top view rotation.

Select Distance option in the Color by field.
Select Selected option in the Lines field.

Set Sparse display off.

Click on All off to switch all classes off.

Click on the row of Ground to set that class on.
Click on Colors on the right side of Color by field.

This opens the Distance coloring dialog:

Distance coloring [ |
Claze. 2 - Ground hd
Compare to: ~ Flightline average hd

tax abowe: | 0250 m
b ax belaw: | 0.250 m
Qutzide color; I:‘

Select 2 - Ground option in the Class field.

Select Flightline average option in the Compare to field.

Key in 0.25 in the Max above field.
Key in 0.25 in the Max below field.
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17.
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19.

20.
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Click on OK.
This opens the Coloring scheme dialog.

Select Open command from File pulldown menu and open the color scheme included in the
tutorial data set, c:\terra\calib\laser\distance.clr.

Click OK to close the Coloring scheme dialog and go back to the Display mode dialog.
Click on Select on the right side of Lines field.

This opens the Display flightlines dialog:

Display fightlines BH
[ Flightline 1 [ ]
O Flightline 2 O
O Flightline 3 |
O Flightline 4 O
Mlon | Aot |

Click on All off to switch all flightlines off.

Click on the row of Flightline 1 to set that on.

Click OK to close the dialog.

The Display mode dialog is You are now back

Click Apply in the Display mode dialog to apply the changes to the display mode.

This changes view 1 to display only flightline 1 using distance coloring. The color of each
point shows how much that point is above or below the average elevation of overlapping
fligtlines at that locations.

Yellow and green colors are less than 0.09 meters from the average surface. Most of the
points should display in yellow or green indicating that the flightlines match each other pretty
well.

Red and blue colors are more than 0.09 meters from the average surface.

You should check other flightlines visually by switching those on one at a time using Select
push button in the Display mode dialog.
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6 TerraMatch tools

TerraMatch tool box

The tools in the TerraMatch tool box are used to define user settings, to perform matching of
laser data and to access on-line help.

TerraMatch E
H

e
innipat

To: Use:

Change user settings Settings

[B]

Define coordinate range and resolution Define Coordinate Setup

Find correction values for laser data Find Match

5

7

+

Apply known correction values

i

Apply Correction

Measure how well flightlines match Measure Match

<5

View information about TerraMatch About TerraMatch

[=] | [@]

View on-line help Help on TerraMatch




Settings

Lih
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Settings tool lets you change a number of settings controling the way TerraMatch works. Selecting
this tool opens the TerraMatch settings window.

Settings are grouped into logical categories. Selecting a category in the list causes the appropriate
controls to be displayed to the right of the category list.

Iteration convergence category

Iteration convergence category determines the stage at which iteration in match finding will stop.
The iteration will stop when the improvements are smaller than these threshold values or when the
match no longer improves.

You may use bigger values if you want to stop the iteration sooner and just find an indication for
the type of error in the data set. You should use small values when you want to find the exact
correction parameters.

Setting: Effect:

Easting Easting convergence (m) - typically between 0.001 and 0.10.
Northing Northing convergence (m) - typically between 0.001 and 0.10.
Elevation Elevation convergence (m) - typically between 0.001 and 0.10.
Heading Heading convergence (deg) - typically between 0.0001 and 0.10.
Roll Roll convergence (deg) - typically between 0.0001 and 0.010.
Pitch Pitch convergence (deg) - typically between 0.0001 and 0.010.

Standard deviations category

Standard deviations category specifies the assumed accuracy of orientation parameters. These
settings help the algorithm to avoid singularity and to better translate observed mismatches into

corrections.

Setting: Effect:

Easting Easting (m) - typically between 0.05 and 0.25.
Northing Northing (m) - typically between 0.05 and 0.25.
Elevation Elevation (m) - typically between 0.05 and 0.25.
Heading Heading (deg) - typically between 0.010 and 0.200.
Roll Roll (deg) - typically between 0.010 and 0.200.
Pitch Pitch (deg) - typically between 0.010 and 0.200.
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Define Coordinate Setup

H
2
E

Define Coordinate Setup tool sets up the coordinate system that TerraMatch uses for laser points.
This coordinate setup determines the coordinate range inside which all laser points must be and
the resolution to which coordinate values are rounded. This coordinate setup is stored into the
active design file and is used by TerraScan, TerraPhoto, TerraModeler and TerraMatch.

TerraMatch uses signed 32 bit integer values for storing coordinates of laser points. This has the
advantage of using only 12 bytes of memory for the coordinate information of each point.

You can control how accurately laser point coordinate values are stored by defining how big each
integer step is. One possible choice is to decide that one integer step is one millimeter. This would
result in all coordinate values being rounded to the closest millimeter. At the same time it would
impose a limitation on how far apart laser points can be or how big the coordinate values can be.
Millimeter steps would produce a coordinate cube which has size 232 millimeters or 4294967.296
meters. [fthe origin of the coordinate system is at [0.0, 0.0, 0.0], this would limit coordinate values
to be between -2147483 and +2147483.

One possibility is to use centimeters for integer steps. This would produce a coordinate range from
-21 million to +21 million which is large enough for most coordinate systems.

To define a coordinate setup:
1. Select the Define Coordinate Setup tool.
This opens the Define Coordinate Setup dialog:

Define Coordinate Setup .

Unitz and resolution
Master unit; |m

Besalution: | 1000 pEr m
Origin
Easting: | 2500000000

HMorthing: | E700000.000
Elewation: | 0.000

Coordinate range

Eastingz:  +352916 . +4B4T484
Marthings:  +4552516 . +8847484
Elewations:  -2147484 . +2147484

Cancel

2. Enter settings values and click OK.

This modifies the coordinate system used by TerraScan, TerraPhoto, TerraModeler and
TerraMatch in the active design file.

MicroStation SE and MicroStation J

Each design file contains a definition of a 32 bit integer coordinate system which MicroStation
uses internally for vector elements. All applications share the same coordinate setup with
MicroStation. When you change the coordinate setup with Define Coordinate Setup, it changes
the design file coordinate system.

MicroStation V8

MicroStation V8 uses 64 bit values for storing vector elements. TerraMatch uses a coordinate
setup which is separate from the design file coordinate system. The application uses a default
coordinate setup of 100 integer steps for each master unit. You can use Define Coordinate Setup
tool to change the coordinate setup which the application stores in the design file but it does not
affect MicroStation itself or the vector elements.
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Find Match

%

-+

Find Match tool performs the actual task TerraMatch is built for: it analyzes the mismatch in laser
data and solves for correction parameters.

Y ou can run Find Match either on points currently loaded into TerraScan’s memory or on a project
definition. When running on a project, TerraMatch will automatically scan thru all project blocks
during one iteration round.

Preprocessing steps

Before you run Find Match, you must have performed a number of preprocessing steps which can
be outlined as:

» Import trajectories into TerraScan.

» Split any trajectories which overlap themselves.

» Import time stamped laser points into TerraScan.

* Make sure flightline numbering of laser points matches trajectory numbers.

* Classify low points.

* Classify ground separately for each flightline.

* (Optional) Classify ground to another class in places which are best suited for comparison.
» (Optional) Classify buildings manually.

* (Optional) Smoothen ground surface if most of it is asphalt or some other hard surface.

Point classes in surface comparison

You can select the classes which to use in surface to surface comparison and how much weight to
apply to each class. This makes it possible to manually classify locations which have sloped
surfaces and to apply a higher weight value to those classes.

You may choose from following strategies:

» Use ground points only and use High weight value for ground.

» Use good surfaces only. Classify suitable locations manually to Building class or Sloped
ground class. Use High weight value for the classes.

» Use both ground points and good surfaces. Classify suitable locations manually. Apply High
weight value to those classes and Low or Medium weight to ground class.
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Running Find Match

>  General procedure for solving for correction parameters:
1. Select the Find Match tool.
This opens the Find match dialog:

Ueer  Loaded points ™

Trajecton dir | ohealibhtrajecton', Browse...
Comect: Al Hightlines hd

Known points: | Browse...

|Jze clagzes eight

1 Default - Select all

2 Ground tarmal

3 Low vegetation
4 Medium vegetation
5 High vegetation

B _Building +| _Deselectal |
Dhzerve eveny: ’1_ th paint
[ Usze intensity

Eolvefor Whale data st ¥ |

[ Easting shift [~ Easting drift
[ Morthing shift [ Morthing drift
[ 2 shift [ Z dift

[+ Heading shift [~ Heading drift
[+ Roll shift [ Roll drift

[+ Pitch shift [~ Pitch drift
[ Miror scale

OF. Cancel

2. Enter setting values and click OK.

The application runs thru a number of iterations which may last anything from a few seconds
to several hours depending on the size of the data set. When the iteration has converged, the
Apply results dialog will open:

Apply results BH
File

Mo known points Bl
Obsgerve every 1th point
Intenzity not uzed

Solution for whole data zet

Standard eror of unit weight: 0.0370

Execution time: 4.9 sec
Mumber of iterations: 2

Faintz 318458

H zhift +0.0555 Std dew 0.0050

R shift 0382 Std dev 0.0039

F =hift -0.0408 Std dew 00036
Ed Flightiine 1 All on
G Fiightline 2 Q
E Flightiine 3

E Flightline 4 & aff

ok Cancel
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3. View the report and optionally store it as a text file.

When using a project, you should set the directory into which output files will be written.

When using loaded points, corrections will be applied to the loaded points in memory.

5. Check all flightlines to which you want to apply the correction in the lower list box.

6. Click OK to apply the corrections.

Find match setting:

Effect:

Use Points to use in comparison: Loaded points or Project points.
. TerraScan project file which defines the blocks to use in
Laser project . i . .
comparison. Selectable only when Use is set to Project points.
Trajectory dir Directory containing TerraScan trajectory files.
Quality of trajectories to correct. This allows you to keep better
Correct quality trajectories as fixed and compute corrections for lower

quality trajectories only.

Known points

Optional text file containing known points.

Use classes

Classes to use in comparison and weight factors to apply.

Observe every

How many points to make an observation with. Use 1 for small
data sets and a bigger value (2-5) for large data sets.

Use intensity

If on, surface will be matched by intensity as well.

Solve for

Type of solution to find:
* Whole data set - one value to apply to the whole data set.
* Individual line - separate correction values for each flightline.

Easting shift

Solves for a constant easting correction value.

Northing shift Solves for a constant northing correction value.

Z shift Solves for a constant elevation correction value.

Heading shift Solves for a constant heading correction value.

Roll shift Solves for a constant roll correction value.

Pitch shift Solves for a constant pitch correction value.

Mirror scale Solves for a mirror scale factor.

Easting drift Solves for easting correction which changes linearly by time.
Northing drift Solves for northing correction which changes linearly by time.
Elevation drift Solves for elevation correction which changes linearly by time.
Heading drift Solves for heading correction which changes linearly by time.
Roll drift Solves for roll correction which changes linearly by time.
Pitch drift Solves for pitch correction which changes linearly by time.

It is a good idea to save the correction parameters into a file using Save corrections menu
command from File pulldown menu in the Apply results dialog. This makes it easy to apply the
found correction later on using Apply Correction tool.
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Apply Correction
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Apply Correction tool applies known correction values to a data set. You can type the correction
values in or you can load those from a file saved when running Find Match tool.

Apply Correction tool makes it possible to use a subset of a large project when solving for
correction parameters but to apply the found solution to the complete project data set.
General procedure for applying corrections:
1. Select the Apply Correction tool.

This opens the Apply corrections dialog:

Apply corrections

Apply to: - Project paints "l
Laser project: | ovmatchiasersmatch. pri Browze. .
wirite tor | comatchicorected, Browsze,
Trajectary dit: | c:\matchhrajecton®, Browse...

Comectionz:  Load from file b
File: | cmatchihrps.tms Browsze...

Cancel

2.  Enter settings values and click OK.

This will open subsequent dialogs where you can enter or verify the correction values to

apply.
Setting: Effect:
Data set to correct:
Apply to * Project points - all blocks referenced by a given project file.
* Loaded points - points loaded into TerraScan.
. TerraScan project file to apply corrections to. Selectable onl
Laser project when Appll; tf) is set to Pl?(fjeyct points. g
Write to Directory into which to write the modified block binary files.
Selectable only when Apply to is set to Project points.
Trajectory dir Directory containing TerraScan trajectory files.
Source of correction values:
Corrections * Enter manually - user types cprrections values.
* Load from file - reads corrections values from a file created
with Find Match tool.
File File containing correction values. Selectable only when
Corrections is set to Load from file.
Type of correction to apply:
Correct * Whole data set - one value to apply to the whole data set.
* Individual lines - separate correction values for each flightline.
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Measure Match
— Measure Match tool measures how well different flightlines match each other. It computes the
o average elevation difference between surfaces from different flightlines.

The report value can be used to determine if laser flightlines are matching each other better or
worse compared to an earlier measurement. You can use this tool:

* Determine if flightlines measure each other at normal level (comparing to earlier projects).
* Determine if a modification applied to laser data was an improvement (comparing to before
modification).

As the comparison is based on surfaces, you should normally perform ground classification on
each flightline individually before running this tool. You may also classify some other suitable
surfaces such as building roofs from each flightline.

Measure Match can use all the points in a project or only loaded points.

>  To measure how well flightlines match:
1. Select the Measure Match tool.

This opens the Measure Match dialog:

Ground

Laows vegetation
Medium vegetation
High weqgetation
Fotential wire -

Measure match [ |
Uze:  Project points v|
Laser project: | &:\hermannitlasershermanni. prj Browse. ..
Uze clazzes
1 Default = Select all

Deszelect all

3
4
]
E

OF. Cancel

Select rows in the list box for the classes to use in the comparison.
3.  Enter rest of the settings values and click OK.

The application computes the average elevation difference between surfaces from different
flightlines and displays that in a report window.
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About TerraMatch

0

About TerraMatch tool opens a window which shows information on TerraScan and on user
license.

Help on TerraMatch

7

Help on TerraMatch tool launches Acrobat Reader for accessing on-line help.

The on-line help is identical in structure to the printed documentation. The on-line version has
hypertext links built in, so you can jump between topics by clicking on the underlined topic names.

Floppy based installation does not include on-line documentation. You can access on-line help

only if you have installed from CD. Accessing on-line help also requires that you have Acrobat
Reader installed on your computer.
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Installation Directories

TerraMatch shares the same directory structure with all Terra Applications. It is recommended
that you install all Terra Applications in the same directory.

The list below shows a typical directory structure when TerraMatch has been installed in path
CA\TERRA.

c:\terra directory where TerraScan was installed
("] config for configuration files

tmatch.cfg  defines environment variables
[ docs for documentation

tmatch.pdf  documentation in Acrobat Reader format
[ license for user license files

tmatch.lic user license
] ma for application files

tmatch.ma  application

tmatch.dll  library

tmatchsb.dll library

[ tmatch for user preferences and settings
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Configuration Variables

MicroStation is able to locate TerraMatch with the help of configuration variables. When you
install TerraMatch, the installation program will create a configuration file TERRA.CFG which
defines the required environment variables. This file is placed in MicroStation's CONFIG\APPL
subdirectory.

For example, CAUSTATION\CONFIG\APPL\TERRA.CFG may contain:

TERRADIR=c:/terra/
TERRACFG=$(TERRADIR)Config/
TERRADOCS=$ (TERRADIR) docs/

MS_MDLAPPS < $(TERRADIR)ma/

o°

if exists ($(TERRACFG) *.cfqg)
include $ (TERRACFG) *.cfg
$endif

o°

This configuration file will include all the configuration files in CA\TERRA\CONFIG directory.
TerraMatch's configuration file TSCAN.CFG contains:

TMATCH_LICENSE=$(TERRADIR)license/

# Directory for user preferences (user has write access)
TMATCH_PREF=$(TERRADIR)tmatCh/

i Directory for settings (may point to read-only directory)

TMATCH SET=$ (TERRADIR) tmatch/
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